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HP Designlet 6 color ProofReady Plugin

1 Introduction

This manual describes the HP DesignJet 6 color ProofReady  plugin for the Harlequin RIP". The plugin deliv-
ers Harlequin RIP optimized output to the printer and provides ‘out-of-the-box’ proofing quality color manage-
ment profiles, hence the name ProofReady.

1.1 Summary of plugin features

*  Support for common paper types at various print resolutions.

*  Provides ProofReady color profiles for instant, expert color management.

*  Provides calibration profiles for common paper types at various print resolutions.

*  Supports a variety of halftone screens (depending on the device selected), including support for optional
preview.

*  Supports a range of print quality settings.

*  Supports output to printer, file and network.

2 System requirements
To operate correctly, the HP DesignJet 6 color plugin requires the following system resources:
. Connection interface, either:
IEEE 1284-compliant bidirectional parallel port. Check your BIOS is set to use bidirectional mode.

HP JetDirect J6057A 10/100Base-TX print server supporting TCP/IP, Appletalk, DSL/LLC and IPX/SPX
protocols.

USB 1.1 (USB 2.0 compliant).

2.1 Windows

These are the platform requirements for a Windows operating system.

«  Intel” Pentium” 4 1 GHz (or equivalent).

«  Microsoft” Windows 2000 (SP 2), Windows XP Professional or Home Edition and Windows Vista.
* 256 megabytes (MB) of RAM (512 MB recommended for variable sized dot devices).

2.2 Apple Mac

These are the platform requirements for a Mac OS X operating system.
*  Intel Mac and PowerPC G4.
*  Mac OS X v.10.4 or later.
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* 64 MB of RAM with virtual memory turned on (128 MB recommended).

2.3 Linux

These are the platform requirements for a Linux operating system.
*  Intel Pentium 4 1 GHz (or equivalent).
*  Red Hat Enterprise Linux ES v4.0.

Note: For each of these platforms, configure the Harlequin RIP with at least 4 MB RAM for the printer buffer
and 24 MB RAM for the system.

3 Installing the plugin

Follow the instructions in this section to install the HP 6 color printer plugin in your Harlequin RIP.

3.1 Installing plugins with the RIP

Insert the Harlequin RIP CD-ROM and open it. Double-click the Install_xx file to load the InstallAnywhere
product installer, which allows you to easily install the Harlequin RIP products contained on the CD. Instruc-
tions for installation can also be found in the install.htm file in the directory above the Install xx file.

1. You may need to log on as System Administrator to ensure you have the necessary privileges for installing
the Harlequin RIP.

2. Follow the InstallAnywhere screen instructions. Select the Next button to move onto the next screen and
the Previous button to return to a previous screen. Note that each screen of the install procedure is labelled
at the left side of the window.

2 Global Graphics Harlequin RIP (Generic)

Introduction

e e
9 InstallAnywhere will guide you through the installation of Global Graphics Harlequin RIP 8.0 (Generic)

@ CHONEEIEERITES
e Cioose sl Folder

& Ciiggza Snarmi F ol Click the ™ext' button to proceed to the next screen. Ifyou want to change sormething on & previous screen, clickthe
Previous' buttan

Itis strongly recommended that vou guit all programs before continuing with this installation

& B lnjgilliion Sy

@ i You may cancel this installation at any time by clicking the ‘Gancel’ buttan
G Inetall Cormpiete

Cancel E——

Figure 1 InstallAnywhere dialog
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The “Choose Features” window shows all the products available in the package. When you select a prod-
uct, a short description of its function appears. Those products not checked in the list will not be installed.

P Global Graphics Harlequin RIP {Generic) == ll

Choose Features

@ Install Set [Custom

@ (=) [ Drivers
@) Giingsa izl Rkl - [ Safelet Sentinel Driver, 7.4.0
) oz Sl Fellar == Harlequin RIP OEM CD

@) HreInzllaiion Sz [ M5 Windsws RIP
L7 M5 Windows Watermark RIP
@ nzizling.. .

. o
O Irzezill Sl ¥ NTPrint Plugin, 2.0r4
- [¥ CIP3 Flugin, 1.4r10
~[¥ ENCAD Plugin, 1.0r1
[~ Epson Plugin, 3.4r3
¥ Epson YsD Plugin, 1.2r1
- |W Epsand00 Plugin, 1.0r1
-~ [¥ Epson7800/9800 Plugin, 1.0r1
- [¥ HP 6-color Plugin, 1.0r3
~[W HPRTL Plugin, 1.0r4
¥ HPSOPS Plugin, 1.0r2
[ HP120 Plugin, 1.0r1
-~ [W HP130 Plugin, 1.0r1
- [¥ TIFF/IT-P1 Plugin, 2.1r2

- [ Toothpick Screening Plugin, 1.0r3 _'LI
Al 3

 Description
Select any dongle device drivers that you wish to install.

The appropriate dongle device driver rmust be installed before atterpting to run a dongle-protected or License Server
versions ofthe Harlequin RIP. This option copies an installation package onto your hard disk for each driver you select. Far
| | information on how to install the selected drivers please refer to the Installation Guide document for this platform
Warning: when installing drivers on a MS Windows platform you may be forced to restart your machine. This is a feature
)| | ofthe MicrasoftWindows Installer

Figure 2 InstallAnywhere Choose Features dialog

Note: Use the scroll bar at the right side of the display to view more selection options.

4.

Use the “Choose Install Folder” window to select an installation folder. If you wish you can choose a differ-
ent install folder to the default. Click Choose... and navigate to the required folder. If at any time you wish
to restore the default location click Restore Default Folder. Click Next to move onto the next stage and
install in the default location.

In a Windows installation, use the “Choose Shortcut Folder” screen to create any icons or Start menu
options. When this is done click Next.

The “Pre-installation Summary” window allows you to examine your installation choices. If required, use
the Previous button to return to earlier screens and modify your selections, otherwise click Install to pro-
ceed with the installation.

A warning dialog may be displayed at his point. Any products on your system that use the Harlequin
License Server should be stopped before continuing with the installation. Click Continue to move ahead
with the installation. Previous versions of the HLS will now be removed. On Mac installations you will be
asked to enter your administrator password at this point in the installation.

The installation will now continue. This may take some minutes.

The “Install Complete” window indicates that the installer has finished. If any errors have occurred a mes-
sage will be displayed. Click Done to exit from the installer. You can view the details of the errors by open-
ing the xx_InstallLog.xml file which is located in the installation folder.

3.2 Installing plugins separately

1.

Follow the InstallAnywhere screen instructions as before. Select the Next button to move onto the next
screen and the Previous button to return to a previous screen.

The “Choose Features” screen shows all the products available in the package. When you select a product,
a short description of its function appears. Select only the plugins that you wish to install. Those products
not checked in the list will not be installed.
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3. On Windows systems in the “Choose Install Folder” screen select the same installation folder as the previ-
ously installed RIP. Click Next to move onto the next stage.

4. At the “Pre-installation Summary” screen click Install to proceed with the installation.
5. The installation will now continue. This may take some minutes.

6. The “Install Complete” screen indicates that the installer has finished. If any errors have occurred a mes-
sage will be displayed. Click Done to exit from the installer. You can view the details of the errors by open-
ing the xx_InstallLog.xml file which is located in the installation folder.

3.3 Screening plugin compatibility

The HP DesignJet 6 color is compatible with the following plugins:
«  HEDSI version 2.1(for 7.x RIPs)

«  HEDS: v3 (for v8.0 and later RIPs)

3.4 Installing screening plugins

HEDS screenin plugins must be installed and enabled in the Harlequin RIP before they can be used.
Depending on which device you choose to use the plugin uses a default screening method, as follows:
. 1-bit single dot size devices (sD)—HDS Super Fine screening

*  2-bit variable dot size devices (vsD)—HEDS2 screening

Other screening methods are possible when using sp devices, for example, HDS Fine/Medium/Coarse/Super
Coarse, HEDSI or EDS. To use a different screen requires you to configure the separation style sheet.

To use any of these screening methods the relevant screening plugin(s) must be installed and enabled in the
Harlequin RIP. Failure to do this will cause the RIP to use Euclidean screening instead in the case of 1-bit
devices, or, in the case of 2-bit devices, may cause the RIP to freeze or unexpectedly quit. The following ver-
sions of the screening plugins are compatible with the ProofReady plugin:

. HEDST1: version 2.1.1 or later.
. HEDS v3.

HDS screening plugins are automatically installed with the RIP and just need to be enabled, however HEDS1
must be installed and enabled separately, as described in the next section.

In addition to the screening plugins, the <name> plugin requires a color management option, such as HIPP (Har-
lequin ICC Profile Processor) or Harlequin ColorPro™ (Eclipse Release™ or later of the Harlequin RIP), to be
enabled.
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3.5 Location of plugin folders

Table 1 shows the correct Harlequin RIP installation folders for the HP DesignJet 6 color and supplied screening
plugins. This information is provided for reference only. Unless instructed by Technical Support, you should not
move these folders or delete information contained in them or the plugins may cease to function correctly.

Source folder Description Destination folder

\hp6col\ HP DesignlJet 6 color | ...\<RIP-folder>\SW\Devices\
plugin

\HEDS1\ HEDSI screening ...\<RIP-folder>\SW\Screenin

\HEDS1\ExtraStart\HEDS 11nit\ ...\<RIP-folder>\SW\Sys\ExtraStart

Table 1 Default installation folders for supplied plugins
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3.6 Enabling plugins in the Harlequin RIP

After installing the plugin files into your RIP, you must enable them in the Configure RIP Extras dialog before
they can be used. To do this you will need your hp6 color plugin password, as supplied to you, as well as pass-
words for color management and screening plugins which may be required.

To enable the HP DesignJet 6 color plugin, color management and screening plugins in the RIP, do the follow-

ing:

1.

Select Harlequin RIP > Configure RIP > Extras, to open the Configure RIP Extras dialog (Figure 3).

x
Feature | En... |;|
TrapPro Mo
TIFFAT Mo
Harlequin CalorPro Mo
PostScript Yes
POF Yos Add...
#PS es
Media Saving Mo
Simple Imposzition Mo
HF, Designlet 120 Senes Mo
HF. Designlet 130 Senes Mo hd
— Try Before You Buy
Trial code: I
L Try.
Ealuation is not enabled

Cancel |

Figure 3 Configure RIP Extras dialog

From the list of RIP extras that are available to you, select HP, DesignJet 5000 Series and click Add.

In the Enable Feature dialog (Figure 4), enter your hp6col plugin password and click OK.

Enable Feature k x|

Fratected Flugin

Enter Pazswaord :

e
o]

Cancel |

Figure 4 Enable Feature password dialog

The HP Designlet 6 color plugin has now been enabled in your RIP, as indicated by Enabled ves in your
extras list.

If it is not already enabled and you want to use the ProofReady profiles supplied with the plugin, you must
enable Harlequin ColorPro in your RIP. Choose the appropriate color management plugin from the list,
click Add and enter your color management password.

Finally, if not already enabled in your RIP, enter passwords for the screening plugins used by the printer’s
output devices. Refer to Table 2 for a list of the printer’s devices and the screens each supports.

When you have finished enabling the new RIP features click OK to close the Configure RIP Extras dialog,
and OK again to close the Configure RIP dialog.

You can now create page setups which use the HP DesignJet devices to process jobs for the HP DesignJet
printer, as described in the next section.

4 Creating a page setup

This section describes how to create a page setup in your RIP that processes jobs for the HP printer.
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1. Select Harlequin RIP > Page Setup Manager, to open the Page Setup Manager (Figure 5).

Page Setup Manager ﬂ

I ame Dewce Resalution Calibration Searatlons Style

D efault Page Setu A 100.0 [Mone]

Edit... Mew... Copy... | [elete | Urits: Idpi 'l
()3 I Cancel |

Figure 5 Page Setup Manager

2. Inthe Page Setup Manger, click New to create a new page setup (or Edit to amend an existing page setup),

to open the New/Edit Page Setup dialog (Figure 6).
x

r~ Output Device r— Resolution

Wertical: 1000 > ks
Configure device... | Horizontal: I‘IDD.U vl dpi ¥

FraofReady: I j ¥ Override resolution in job

Device:

— Separations, Screening & Color ——————— [ Processing

Style: IEMYKEomposite j El Optimization: INone 'l
Calor: I[NoEoIorManagement] j ml Exposure; I

r~ Trapping

Method: [None] - conﬁgu,e___l [~ Enable Feature

Freferences: I j @l I J
i~ Calibration & Dot Gain —Effects

Megati
Calibration: [None] L Bl
| H I~ Mirrarprint
Tone Curves: INone] l B Gl i
ontrol strip
Intended Press: I[None]
Rotate: ID 'l

Sctusl Fress: I [Mone] j

" Trim page

— Cazzette & Page ~ Scaling

Lazsette: I j @l
Wertical: |1 00.00 4
FPage layout... |
j El Horizontal: |1DD.DD %

Imposition: I [Maone]

Options... | FDF Options... | #PS Options... | QK I Cancel |

Figure 6 Page Setup dialog
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Enter information in the fields as follows:

Device: Select a device from the list. The device you select will largely depend on the dot type,
screening method and resolution you prefer to use. See Table 2 for details about which dot types are
supported and the screening modes that are available.

ProofReady: Select a ProofReady profile to use for color managed output. Your choice of profile will
mainly depend on the paper type installed in your printer, but it may also be influenced by the output
resolution you want to use. See Table 3 for details of ProofReady profiles that are available and the
HP paper type and resolutions each has been optimized for.

Resolution: This setting is automatically chosen by the ProofReady profile for this device. Unless
you have good reason to do so, do not change the resolution settings.

Style: This setting is automatically chosen to suit the selected device. Do not change this setting.

Color: This setting is automatically chosen to suit the selected profile. However, if you wish to use
your own color profile, choose it instead from the list. See, “Creating color setups” on page 27 for a
description of how to create your own color setups.

Calibration: Set this to (None). Calibration is pre-defined by the ProofReady profile. However, to
achieve even better results, you may wish to create your own calibration profile for the machine you
are outputting using the correct paper. To do this, see “Calibrating the printer” on page 24.

Click Configure Device to open the Configure Device dialog, which allows you to specify output options
for the selected device. For example, it allows you to specify the output method (file, network (including a
print server) or LPT1), media type, and output quality.

Click Page Layout and choose the paper size installed in the printer. If the job is an EPS file, or the job does
not contain page size information (most jobs do), set the page size too.

If it is necessary to do so, you can adjust the positioning of the output on the media by adjusting the page
margin values. See, “Page Layout options” on page 8 for details.

Click Save As and choose an appropriate name for your new page setup.

Click OK to close the Page Setup Manager.

The page setup has now been created and may be used to process jobs. Remember to create page setups for each
type of paper that you use in your printer, choosing the device type and ProofReady profile to match.
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4.1 Page Layout options

The options in Page Layout are used to specify your media size and page size when not defined in the job itself.
Page size refers to the ‘frame’ into which the job is printed; media size refers to the size of the paper installed in
the printer. To prevent clipping of your print, the page size must not exceed the media size.

Media size

A
A 4

A
allfeinthedayof....

— 71— Media

Page

< .
Page size

Figure 7 Media and page sizes

In most jobs the page size has been defined in the page design and embedded in the PostScript language file. The
page size in Page Layout has no effect on these types of jobs. In EPS files, or other jobs where page size is not
defined, you must select the correct page size from those listed in Page Layout.

When changing the margins be careful not to increase the margins beyond the limit of the media. Setting a value
for the bottom margin beyond the media size on sheet fed devices will result in a loss of printable space on the
media.

5 Configuring Harlequin RIP devices

The devices installed by the plugin can be configured to suit your output preferences using the options in the
Configure Device window. It is not usually necessary to reconfigure a device unless you are outputting directly
to the printer, or need to change the output quality or add post processing commands.

x
Output Method: I File - l
~ File Output r~ Output
Change ... | IE:\Program Filez"HarlequinRIP_8_0_ Paper Size |42" Rall j
File Template |& ut< Sunigues ¢ dat hpf Guality IBest j
C . - - -
~ Network utput ompression ITIFF [Packbitz] Encoding J
IP Address |1 27001 Cut paper at end of each page [
Port Mumber IS‘I i} Post Proceszing I

()3 I Cancel

Figure 8 The Configuration Device window

To configure a Harlequin RIP device, do the following:
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1. Inthe <name>, click Harlequin RIP > Page Setup Manager, or use the shortcut key Ctrl+S to open the Page
Setup Manager.

2. Click New to create a new page setup, or Edit if you already have one that you wish to amend.

3.  With the appropriate device selected, click Configure Device to open the Configure Device window, which
is shown in Figure 8 on page 9. The following device configuration options are available:

Output method

Select the output method from the following choices:

File (Default option). Output is saved to the location specified in the File output
option, and named according to the settings in File template.

Network Select this option if using the JetDirect network card. IP Address and Port
number should also be specified when Network is selected.

LPT1 Select this option if you are connecting via a parallel port.

USB Select this option if you are connecting via a USB port.
File output

Allows you to specify the output location when File is selected as the output method. If you do not change
the location, output is placed in ...RIP folder\sw\.

Note: You can send files to a printer using Windows print spooling by installing Windows printer drivers on
a PC print server, and by entering the name of the print server in this text box.

File template

This option allows you to use tags to construct the name of the output file. For example,
<dos>out<5unique><dot>hpf produces out00001.hpf, out00002.hpf. See Table 5 on page 19 for a
complete list of permitted tags.

IP address

If you selected Network as the output method enter the correct IP address or network name of the printer,
otherwise leave this field at the default setting.
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Port number

If you selected Network as the output method enter the port number of the printer, otherwise leave this field
at the default setting.The printer supports the following ports:

*  Port 515: Sets the LPR protocol when using the JetDirect network card. Note that the LPR protocol
does not provide bidirectional communication with the printer. Consequently, the printer cannot
report error messages when using this protocol.

e Port 9100: Sets the JetDirect protocol when using the JetDirect network card. Select 9100 if you are
using an external print server. Some external print servers can drive several printers simultaneously.
In this case the different physical connections or ports have their own numbers (which may vary with
the type of server). For example, on an external unit with three output ports, the physical ports named
1, 2, and 3 have port numbers 9100, 9101, and 9102.

Note: The LPR protocol does not provide bidirectional communication with the printer. Conse-
quently the printer cannot report error messages when using this protocol. Use port number 9100 to
avoid this.

If you are using an external print server you must set the Port Number to 9100, or a similar number.

Some external print servers can drive several printers simultaneously. In this case the different physi-
cal connections or ports have their own numbers (which may vary with the type of server). For exam-
ple, on an external unit with three output ports, the physical ports named 1, 2, and 3 have port
numbers 9100, 9101, and 9102.

The RIP supports the use of another printer connected to the same print server. For example, two
computers running the RIP and driving the same print server can address any compatible printer con-
nected to that server.

Quality

This option can be used to specify print output quality. For information on the quality setting and the effect
it has on your printed output, refer to your printer manual. The following quality options may be available
depending on the resolution:

*  Best: (Default) Highest print quality but slowest print speed. This is the recommended setting to use
for the supplied profiles.

*  Normal: Standard output quality with medium print speed.
*  Fast: Lowest print quality but fastest print speed.
Compression

This option can be used to specify the encoding method used when data is sent to the printer, which can
affect the transfer rate for data sent to the printer. The plugin supports two compression modes:

None Data is transferred uncompressed, resulting in longer data transfer times to the
printer.
TIFF (Packbits) Data is sent compressed, resulting in faster transfer times to the printer without

any loss in print quality.
Paper size
This option is used to select the paper size installed in the printer in previous versions of the Harlequin RIP.
Paper bin

This option can be used to select the printer’s paper bin source. The following options are available:

Paper tray 1 Sets the paper source to Paper tray one.

AG50324 Rev. 7 11



USER GUIDE FOR HP 6 COLOR PLUGIN

Paper tray 2 Sets the paper source to Paper tray two.

Manual feed front Sets the paper source to manual feed from the front of the device.

Manual feed rear Sets the paper source to manual feed from the rear of the device.

Auto select Automatically selects the paper source that contains the paper size specified in

the Device Configuration dialog box. If the specified paper size is unavailable
an appropriate alternative will be chosen automatically.

Post processing

This option can be used to specify commands that will be executed after a job has been processed. For
example, you may wish to change the format of the output file or generate a report. For full details see
“Post processing operations” on page 21.

This option is not supported on Macintosh computers.

6 Devices

The HP DesignJet plugin adds several new devices to the <name> for selection in your page setups. Two
devices types are supported:

*  “SD” devices print a fixed dot size: small or large dot. Dot sizes cannot be mixed on the same page.

e “VSD” devices print a variable dot size: small, medium and large dot. Dot sizes can be mixed on the same
page.

Your choice of device type will mostly depend on the halftone screening method that you prefer to use. See the
table, “Devices installed by the plugin” on page 12 for a list of the screen types supported by each device. In
most cases, your choice of device will be determined by your favored dot shape to use for a particular job. If you
are not sure which to use, refer to “Description of screening modes” on page 15 for a brief description of the var-
ious screening modes which are available for each dot shape. Initially, a little trial and error may be necessary
before the optimum dot shape/screening mode is found

Warning: Output quality may be impaired if the appropriate screening plugin used
by a device is not enabled in the <name>. See “Installing the plugin” on page 2.

Device Dot type Screening modes Color modes

Table 2 Devices installed by the plugin

6.1 Adding output devices

Depending on how the plugin has been supplied to you, some HP DesignJet 5000 output devices may not be
available for selection in the Device list in a page setup dialog. Table 2 lists all the output devices that are avail-
able with the HP DesignJet 6 color plugin: if an output device you wish to use is not available, you may add it.
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To add a print device, do the following:

1. Select Harlequin RIP > Device Manager to open the Device Manager (Figure 9).

Device Manager

Flugin:
Mame | Type | Address |
Edit.. Mew... | Capy... | [elete |

Select | ()3 I Cancel |

Figure 9 Device Manager

2. Select hp6col.i32 (Windows) or hp6col (Mac OS X) in the Plugin drop-down list.
3. Click New to open the Device Manager Edit dialog box (Figure 10).

x
M ame: l—
L |
Address: I Cancel |

Figure 10 The Device Manager Edit dialog

¢ Name: Enter a name for your new device. We recommend that you enter a name which matches the
Type selection, including the exact same combination of upper and lower case letters.

*  Type: Select a device from the drop-down list to specify the device type you wish to add.
*  Address: Ignore this option as it is not required.
4. Click OK to add your new device, and OK again to close the Device Manager dialog.

Your new device will now be available for selection in the Device drop-down list in the page setup dialog.

7 ProofReady profiles

The HP DesignJet6 color plugin is supplied with several ProofReady color profiles for ‘out-of-the-box’ color
management. Simply choose a ProofReady profile in your page setup, according to the paper type installed in
your printer (see Table 3 for supported paper types), and color will be automatically handled in the RIP to pro-
duce accurate, consistent and ‘pleasing to the eye’ output.

7.1 Supplied ProofReady profiles

Each ProofReady profile supplied with the HP DesignJet 6 color plugin has been created for a specific HP paper
type at a specific resolution. For best results, you should always use the recommended paper, as listed in Table 3,
and leave the resolution at the default setting.
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Note: If the ProofReady profile drop-down list in not available in your page setup, enable color management in
your RIP.

Resolution

ProofReady profile Device Paper type (HP Ref) (dpi)

HP Photo Gloss 600 DJ5000 Contone | Photo Imaging Gloss 600x600

42 Sheet C6964A, C6965A
DJ5000 Contone
42 Sheet

DJ5000 60
Contone Roll

DJ5000 60
Contone Sheet

HP Photo Gloss 600 DJ5000 Contone | Photo Imaging Gloss 600x600

42 Sheet C6964A, C6965A
DJ5000 Contone
42 Sheet

DJ5000 6-Col 42
Roll

DJ5000 6-Col 42
Sheet

DJ5000 Contone
60 Roll

DJ5000 Contone
60 Sheet

DJ5000 6-Col 60
Roll

DJ5000 6-Col 60
Sheet

Table 3 HP 6 color ProofReady profiles

7.2 Changing the default screening method

The screening mode used in an output device may be changed if the device supports alternative screens. Refer to
Table 1 on page 5 for a list of devices and the screens they support.

To change the screening method used by a device, do the following:

1.
2.
3.

In the Harlequin RIP, choose Color > Separations Manager to open the Separations Manager.
From the Device list, select the HP Designjet device that you want to configure.

From the Style Name list, select the style you want to change, and choose Edit to open the Edit Style dialog,
Figure 11.

From the Dot shape menu, select the screening method you want to use.
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5. Choose OK to make your selection, and OK again to close the Separations Manager.

Edit Style for ‘PhotoInk Composite® - PhotoInk - Composite - PhotoInk ﬂ

Separations are Separation Frirt 7 Angle . L
generated in list Photo Elack s [V Overiide separations in job
order. Photo Cyan Yes
Set print to Ves' to Phata Magenta Yes ¥ Use Level 1 spot colors

: ’ Phota vellow es
automaticaly print Phota Cyan Light Yes ™| Oweride angles i job

‘ath lors in job’. .
e Photo Magenta Light  Ves . .
" Reject preseparated jobs

™ Recombing preseparated jobs

Edit selected row: Phato Black Yes jl =0 | Delete | ‘
Dat shape: IHDS Super Fine j V' Overide dat shape in job
Fesolution(s | Frequency |

Select row to edit
fTECI_UENC}' for . ¥ | Oweride frequency i job
device resolution.

Edit selected row: I j I I j ‘

[ Generate extra gray levels Lirnit number of distinet gray levels o | 256 -

™ Usze Harlequin Precision Sereeting: HFS Options... |
¥ Rotate screens according bo page otation QK I Cancel

Figure 11 Edit Style dialog

7.3 Description of screening modes

This section briefly describes the assorted screening modes (also know as ‘dot shapes’) supported by the HP
Designjet plugin. Not every device that is installed by the plugin supports all dot shapes/screening modes.

HEDSI HEDSI1 (Harlequin 1-bit Error Diffusion Screening) is a frequency modulated
(FM) screening method particularly suited to the production of proofs on inkjet
printers. HEDS1 works well at low resolutions, since it does not use dot pat-
terns, producing prints that are free from the moire effect. To use round HEDS1
screening, choose HEDS1 from the Dot shape drop-down list.

HEDS?2 HEDS?2 (Harlequin 2-bit Error Diffusion Screening) produces the highest qual-
ity output for inkjet printers.

Screens are produced with multiple dot sizes: small, medium and large. To use
round HEDS2 screening, choose HEDS2 from the Dot shape drop-down list.

8 Output file naming

Using variable tags and fixed text you can set up a file naming template for your output files. Using a template
ensures your output files will be named consistently, and, depending on which tags you use, with appropriate job
information to identify the output file correctly.
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To implement your file naming template, add the appropriate tags and text (if needed) to the File template field
of the Configure Device dialog for the device you wish to use.

51
Out
Output method [Fis o i
Qually [Best =
 File output
i Compression: [ TIFF (Packbis) =
Folder [ \Frogram Files\HarlequinRIF_B_0_Generich
) : Paper size: [Media size fiom "Page Layout” E
File template field ——— Fietemplate:  [<dos>ouicSunique: <dot>hpt ; I B
Papertiv.  [Rollfesd [Z]

~Netwark output

P address: [127.001

Pt rumber:

[¥ Cut paper at end of sach page

Media
[ Mediatype: | Unknown =l
| Post pracessing s
I~ Enable ¥ Create window
Command:
Corce

Figure 12 Configure Device dialog showing File template field

AG50324 Rev. 7 16



USER GUIDE FOR HP 6 COLOR PLUGIN

8.1 Tag usage
There are a few rules to keep in mind when using tags:

*  You may limit the length of any expanded (derived) file name by using an integer before the tag. For
example, <5jobname> limits the name to a maximum of 5 characters.

*  Tags which produce numeric values are truncated from left to right.

*  Tags that produce alphanumeric strings (strings containing the characters a-z, A-Z, and 0-9) are truncated
from right to left.

*  Fixed text can be part of the file name stem or extension. For example,
stem <3uniques><sepnames<dot>hpf would generate a file name of the form: stem 000Cyan.hpf, in
which stem_can be any identifying text.

e The tags will not produce useful file names from job names that contain double-byte characters.

*  When creating multiple copies of a file, the same page buffer provides tag information. If a template con-
tains dynamic tags (such as <time>, where the value changes each time a page buffer file is output), mul-
tiple copies of the file are created. If the template contains just static tags (such as <jobname>, where the
job name remains constant), a single output file will be created, as previous output files will be overwrit-
ten.

8.2 Checking tags

The plugin always checks the legality of an automatically generated file name against the requirements of the
operating system on which the RIP and the plugin are running.

To enable portability of files from one operating system to another, you can also use tags to specify the operating
system for which generated file names must be suitable. The use of these tags changes the rules by which a file
name is deemed valid. The tags do not modify the file names generated, but cause error messages if the file
name is invalid. See “Messages for file name templates” on page 32 for details.

For example, you can create the template <dos>Averylongfilename<dot>hpf, but an error is generated. This
error occurs because DOS file names require the 8.3 format for stem and extension, which this template fails to
meet by having 17 characters in its stem. Table 4 lists the operating system tags.

Examples of tag usage

The following examples demonstrate the format of strings produced by individual tags. Some examples also
show how the tags may be used in combination to form a template. The examples are based on these job details:

Page buffer name: 1. Uncalibrated Target: Default CMYK + spot colors target
Date: 29th of January, 2007

Compression: Packbits Encoding

Quality: Best

Note: When creating multiple copies of a file, the same page buffer provides tag information. If a template con-
tains dynamic tags (such as <times>, where the value changes each time a page buffer file is output), multiple
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copies of the file are created. If the template contains just static tags (such as <jobname>, where the job name
remains constant), a single output file is created because previous files are overwritten.

Tag Description

<ascii> Limits the character set of the file name (from the point of the tag onwards)
to ascii characters in the range 32 (0x20) to 126 (0x7E). Characters outside
this range are discarded. To substitute invalid characters rather than dis-
carding them, prefix the tag with the substitution character value in deci-
mal.

<dos> Verifies that the file name is a legal file name for the MS-DOS operating
system.

The use of this tag verifies that the file name is suitable for use in a DOS
operating system. Illegal characters such as a colon, and white space char-
acters cause an error.

For example, the template <dos><jobname><dot>hpf, would generate an
illegal file name because the job name could be greater than the eight char-
acters allowed in DOS operating systems. Truncation can be forced by
using the template <dos><87jobnames><dot >hpf, which produces the file
name Uncalibr.hpf.

<mac> Verifies that the file name is a legal file name for the Macintosh operating
system.

The use of this tag verifies that the file name is suitable for use in a
Macintosh operating system. Illegal characters such as an asterisk, colon,
and quotation marks cause an error. The maximum length of a file name is
thirty-one characters (including the file extension).

For example, using the template <mac><28jobname><dot>hpf produces
the file name Uncalibrated Target Default.hpf, in which the colon
has been removed.

<macosx> Verifies that the file name is a legal file name for the Mac OS X operating
system.

<unix> Verifies that the file name is a legal file name for the UNIX operating
system.

The use of this tag verifies that the file name is suitable for use in the
UNIX operating system. Illegal characters such as an asterisk, colon, and
quotation marks cause an error. The <dot > tag cannot be used with this tag
because file names in UNIX are composed of a single string and are not
considered to have separate file extensions.

For example, using the template <unix><255jobname>.hpf produces the
file name UncalibratedTargetDefaultCMYK+spotcolorstarget .hpf,
in which the colon and white space characters have been removed.

<win32> Verifies that the file name is a legal file name for Windows operating
systems:

The use of this tag verifies that the file name is suitable for use in a
Windows operating system. Illegal characters such as an asterisk, colon, or
quotation marks cause an error.

For example, the template <win32><jobname><dot>hpf produces the file
name Uncalibrated Target Default CMYK + spot colors
target .hpf, in which the colon has been removed.

Table 4 Operating system tags
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9 Content generating tags

The following tags are available and can be used in any order.

Tag Description

<colorant> The color space of the device, such as DeviceCMYK or DeviceRGB.

The tag includes the color space of the device in the file name string. For
example, the template <colorant><dot>hpf produces a file name of
the form DevicecMYK. hpf for a device using a CMYK color space (4-
colors) or a file name of the form PhotoInk.hpf for a device using a
Photolnk color space (6-colors).

<compression> The form of compression used, such as Packbits.

You can use this tag to include the form of compression used in the file
name. For example, based on the job details above, the template
<compression><dot>hpf produces the file name pPackbits.hpf.

<date> The date when the job is processed, in the format yyyymMMmDD, unless a
truncated form is specified.

The template <date><dot>hpf produces the file name 20070129 . hpf.
You can remove the year information by using the tag <4dates> to pro-
duce the file name 0129 . hpf.

<dot> Separates the stem of the file name from the file extension, and appears
as a period character ( . ) in the file name. For example
stem<dot>ext appears as stem. ext. The use of the <dot > tag enables
the verification of the stem and extension lengths.

This tag separates the file name stem from the file name extension and
enables the verification of their lengths. It is particularly necessary when
creating file names compatible with DOS and Windows, otherwise the
extension may be considered as part of the file name.

For example, the template <dos><8jobname>.hpf would cause an error
because the dot is removed as an illegal character and hpf is then con-
sidered part of the file name stem.

<job#> The job number allocated by the RIP. Automatic numbering means that
successive jobs have incremental job numbers: 000, 001, 002, 003, and
S0 on.

You can use this tag to include the job number in the file name string.
The default length of the number is three digits, so the first job number
created with this tag would be 000, unless a different length is specified.
You can specify the length of the job number by preceding the <job#>
tag with an integer. For example, <55 ob#> creates job numbers five
digits long.

In multi-page jobs use the <page#> tag as well as the <job#> tag to dif-
ferentiate between the different pages of a job.

Table 5 File renaming tags
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Tag Description

<jobname> The page buffer name without the page number prefix and without char-
acters illegal to the operating system. White space characters are used, if
present in the job name.

This tag ensures that only legal operating system characters are used in
the job name.

For example, in the RIP running under any Windows operating system,
the template <jobnames><dot>hpf produces the file name
Uncalibrated Target Default CMYK + spot colors target.hp
£. The colon character ( : ) is removed from the file name, because this
is not a valid file name character for any version of Microsoft Windows,

<jobnamel> The page buffer name without the page number prefix, and using only
alphanumeric characters (a-z, A-Z, 0-9). White space characters are not
used.

This tag ensures that only alphanumeric characters are used in the job
name.

For example, in the RIP running under a Windows operating system, the
template <jobnamels<dot>hpf produces the file name
UncalibratedTargetDefaultCMYKspotcolorstarget.hpf. The
colon, white space, and ‘+’ characters are removed from the file name,
because they are not alphanumeric characters.

<jobonly> This gives the job name without the separation name in brackets, For
example, where <jobname> would give myjob(PANTONE Reflex
Blue CVC), <jobonlys> will give myjob.

<page#> The page number (allocated by the RIP), within the current job. For
example: 002.

You can use this tag to include the page number in the file name string.

For example, the template <page#><dot>hpf produces a file name of
the form 001 .hp£. It is advisable to use this tag with the <job#> tag to
differentiate between the same pages of different jobs.

<prefix> The page number prefix from the page buffer name, suchas 1., 2., and
SO on.

You can use this tag to include the page number prefix from the page
buffer name in the file name string.

For example, based on the page buffer name above, the template
<prefix><jobnames><dot>hpf produces the file name 1.
Uncalibrated Target Default CMYK + spot colors
target.hpf.

<prefixonly> You can use this tag to include the characters from the prefix before the
full stop in the job name (that is, the prefix, not including the dot and
space characters).

Table 5 File renaming tags (Continued)
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Tag Description

<time> The time when the job is processed, in the 24-hour format HHMMSS,
unless a truncated form is specified.

You can use this tag to include the time a file is processed in the file
name string.

For example, if printing to file at 15:39:36 (approximately 3:39 pm) this
tag produces the string 153936.

<unique> A unique sequence number used to make every file different when plac-
ing output files in a folder.

You can use this tag to generate a unique sequence number for the page.
The default length of the number generated is four digits long, so the
first number would be 0000. The length of the number can be specified,
as detailed in the example for the tag <job#>.

When restarting the RIP, the unique numbering will attempt to restart at
its initial value, for example oooo. However, if a file exists with that
number, the next available unique number is used.

<xres> The horizontal resolution of the page, as specified in the page setup.

You can use this tag to include the horizontal resolution of the page in
the file name string.

For example, you can differentiate between pages with a resolution of
600 x 600 dpi and 300 x 300 dpi by using this tag. This tag produces a
string such as 600 or 300, depending on the horizontal resolution.

<yres> The vertical resolution of the page, as specified in the page setup.

You can use this tag to include the vertical resolution of the page in the
file name string. For example, on a page with the resolution 600 x 600,
this tag produces the string 600.

Table 5 File renaming tags (Continued)

10 Post processing operations

The plugin Configuration dialog box has an Output: Post Processing text box in which you can enter commands
and their options, in the same way as a command line. These commands are carried out after the page buffer has
been sent to the printer or once the output file has been created. The commands available depend on the platform
on which you are running the RIP.

Note: You cannot perform post processing if you are using a Macintosh computer.

The command can be a simple batch file or a complex application, provided that you give the command all nec-
essary options and information; a command needing operator intervention is likely to cause problems. You can
specify options understood by the application, and data such as the path of the relevant input or output files.

You can use post processing commands to convert the file to a different format or to send somebody an e-mail
notifying them that a job has been processed. There are several other possibilities, such as extracting information
for use in reports, limited only by your ability to obtain or create a suitable application and to supply information
to it.

If the string you enter into the Output: Post Processing text box refers to a post processing application then this
application must be available on the computer running the RIP. The string should normally include the file
extension and the full path name of the application file. However, you can type just the file name if the applica-
tion file has the extension .EXE and is in one of the directories specified by the PATH variable.
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Your string can contain substitution codes, which are expanded by the RIP. See “Post processing operations” on
page 21 for details.

10.1 Post processing substitution codes

When using the post processing feature of the HP Designjet plugin, the RIP recognizes the substitution codes in
the following list. You can insert an integer between the percent character and the letter code, to restrict the max-
imum number of characters used in the result string. For example, %67 represents the first six characters of the
job name.

Tag Description
%c The current separation color, represented by a string with a default

length of one character. Typical separation names are Cyan, Magenta,
vellow and Black. Examples for the default length are: ¢, v, M, and B,

%d The current date in the format YYYYMMDD, with a default string
length of 8. For example, 26 May 2007 becomes: 20070526.
% The output file name, as created by the template specified in the File

Output: File Template text box in the Configuration dialog box. For
example: out00001 . hpf.

oe
(-]

The current page buffer name as shown in the Output
Controller/Monitor. For example: 1. Apple.ps.

o°
=]

The current job number, an integer that the RIP increments each time
it processes a new job. For example: 15.

o°
(¢}

The full output directory path specified in the File Output: Change...
text box. For example: C:\SWNT\SW\Output\.

%p The current page number within the job. For example: 4.

s The job resolution in dots per inch. For example: 300.

%s The current job name, after removal of all the characters that would be
illegal in a file name. For example: Appleps.

%9 A fixed jobname using the following rules:

1. Skip over the leading nn. which the RIP pre-pends.
2. Remove all non-alphanumeric characters.

st The current time in the format HHMMSS, using the 24 hour clock.
The default length is 6. For example, a time just after 7:30 pm would
be shown: 193211.

o
bl

The current file name suffix. For example: hpf.

o°
N

The current file name stem. For example: out00001.

Table 6 Post processing substitution codes

10.2 Checking the command string

The RIP reports each command and the working directory in the main RIP monitor window, in the following
form. Italics show which text can vary with different jobs and page setups.
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Running post-job command "C:\test\logfile.bat out00002.hpf 112442" in directory
C: \SWNT\SW\Output

The above example refers to a batch file (1ogfile.bat) which uses a program to send an e-mail confirming
that a job has been processed. The e-mail contains the job name (out 00002 . hpf) and the time it was pro-
cessed (approximately 11:24). These details were provided by using the substitution codes $£ and %t in the post
processing text box. The working directory is the output file folder specified in the File Output: Change... text
box. If no output file folder is specified then the working directory is the . . \sw\’ directory, which is one level
below the directory containing the RIP executable.

For a more thorough test of how commands behave when used at the command prompt of the operating system,
try creating a batch (. BaT) file with these contents and using the name of the batch file as the application in your
command string.

o°

echo %1 %2 %3 %4
pause

5

o°
(o))
o°
~
o°
\o)

Note: If you have problems with a command, test it outside the RIP by opening a command window and running
the command manually. If you think that you have used any substitution code from which the RIP might gener-
ate an element containing characters with a special meaning to your operating system, try surrounding that code
with double quotes. For example, use "$£" in the post processing text box rather than just $£.

If there are no special characters involved, look at the number of substitution codes that you are using and the
length of the command string both before and after expansion of the substitution codes. The limit on the length
of the expanded command string varies with the Microsoft Windows environment but you should have no prob-
lems with up to 125 characters in the string after expansion.

10.3 Command line monitoring

The RIP uses the monitor window to report the post processing commands that have been run. Typical output
takes the form:

Running post-job command "C:\test\logfile.bat out00002.hpf 112442" in directory
C:\SWNT\SW\Output

where:
C:\test\logfile.bat is a batch file
out00002.hpf is data used by the batch file. See 3£ in Table 6
112442 is the time (11:24) the job was processed. See st in Table 6.

C:\SWNT\SW\Output is the working folder specified in Device Configuration, see “Configuring
Harlequin RIP devices” on page 9 for more information. Also see %o in Table 6.
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10.4 Troubleshooting post processing command

Your post processing commands might not execute as you would expect them to. If this is the case, there are a
number of troubleshooting tips which you can follow:

*  Open a command dialog and run the post processing command there.

* A substitution code may be being misinterpreted by your operating system. Try enclosing the substi-
tution code in double quotes, for example "s£".

*  The total length of the expanded command line may be too long for your operating system to handle.
Expanded means after the full text has been inserted for the substitution codes. All systems will sup-
port command lines up to125 characters: many support command lines considerably longer.

e For a thorough test of how commands behave when used at the command prompt, try running a batch
file with the following content:

echo %1 %2 %3 %4 %5
pause

o°

6 %7

o°

9

11 Color management

The HP Designjet plugin provides ProofReady profiles for ‘out-of-the-box’ color management. The profiles
adjust color output to suit the resolution and paper type installed in the printer, ensuring that output is color accu-
rate for whatever media settings are in use.

For more information on the Harlequin RIP color management solutions, see the Harlequin ColorPro" Users
Guide and Chapter 13 of the RIPMate User Guide, “Calibration”.

This section briefly describes the complete color management process, including:
*  “Calibrating the printer” on page 24.
*  “Creating and installing ICC profiles” on page 25.

*  “Creating color setups” on page 27.

11.1 Calibrating the printer

The plugin is supplied with a number of reference calibration profiles which define the output profile of an ideal,
or ‘reference’, HP DesignJet printer. In your page setups, when you select a ProofReady profile the correct cal-
ibration profile is automatically chosen by the plugin. However, for maximum output quality, we recommend
that you produce calibration profiles for your own printer, and select these in the Calibration drop-down list in
your page setups.

The reference calibration profile supplied with the plugin are easy to identify, since they are labelled with paren-
theses; for example, (Premium Photo 1200). The actual calibration profile files can be found in the following
folder:

..\<RIP_ folder>\SW\Config\Devices\DevCalibration\

The steps for creating a calibration profile vary depending on the version of RIP you are running. See See Chap-
ter 13 “Calibration” of the RIPMate User Guide for information on creating a calibration profile.
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11.1.1 Recalibrating the printer

To maintain printer calibration accuracy, you should periodically recalibrate your HP printer. This is particu-
larly important if the paper, ink, or some other variable (including ambient room conditions) changes.

To recalibrate the printer, do the following:

1.  Click Output > Print Calibration to open the Print Calibration window.

2. Select the correct page setup you are using to output to the installed paper, and click Print calibrated target.
3. Measure the target with Genlin
4

Open the Calibration (Dot Gain) Manager and select the calibration set assigned to the page setup. Then
click Edit from calibrated target.

5. Inthe Edited calibrated target dialog, click Import > Import to read the calibration data. You may also wish
to specify a new profile name, to indicate, such as HP  Photo Gloss-Aug2007, to indicate the date the
profile was updated.

6. Click OK to save the modified and updated profile. If you have changed the name of the calibration profile,
remember to edit your page setups to use the new calibration profile. If you have not changed the name,
you do not need to do this.

11.2 Creating and installing ICC profiles
To create and install a new ICC profile, do the following:
1. “Create a suitable page setup” on page 25.

2. “Print and measure an ICC target” on page 26.

3. “Install the ICC profile in your RIP” on page 26.

11.2.1 Create a suitable page setup

To process the ICC profiling targets and output them to a printer, you will need to create a page setup which uses
the correct printer model, media type, ink and output quality. The page setup must not have any color manage-
ment or calibration options selected; these should be set to (None) or (No color management) as applicable.
Or, if you have created a “Golden State” profile for the printer, using Global Graphics’ SetGold utility for exam-
ple, you may select the profile and use it as a suitable reference state for the printer.

Having created a suitable page setup, use it to print the ICC profiling target and measure it using an appropriate
software package.

The exact procedure you should use varies from package to package, but it is possible to give some general
hints:

*  Total area coverage: For some paper types the total area coverage should be limited. This depends on the
paper, ink type, resolution and screening used, but a good guide is to limit the coverage for coated media
(Premium) to 280%, whereas matte media should be around 320%. Some experimentation may be
required to determine the optimum setting.

e Number of patches: Although the number of color patches printed and measured is not always a guide to
color quality, it is generally true that printing more patches produces better results for any given ICC pro-
filing package.

Having created the ICC profile, install it using the menu option Color > Install ICC Profile. In the Linear
Calibration From menu in the Install ICC Profile dialog box choose either:

*  Linear if the page setup you used contained no color management data (raw state); or
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*  The name of the calibration profile or calibration set that you used in the page setup (golden state). The
calibration data is incorporated into the ICC profile when you import it. This means you can delete the
temporary calibration profile or calibration set once you have imported the ICC profile.

You can create a color setup using this profile (see “Creating color setups” on page 27 for details).

11.2.2 Print and measure an ICC target

Using your page setup, print the ICC target and measure it with your favorite profiling tool, and save the profile
to a suitable location.

Some hints for obtaining better results:

»  Total area coverage: For some paper types the total area coverage should be limited. This depends on the
paper, resolution and screening used, but a good guide is to limit the coverage to 280% for uncoated
papers and to 340% for coated papers. Some experimentation may be required to determine the optimum
setting.

»  Black generation: The presence of black ink in highlights can in some cases be objectionable and can
introduce an unnecessarily grainy appearance to some images. Select a setting which images black only in
dark regions. (If it is not clear which settings will image black only in dark regions, select the minimum
amount of black generation allowed by the ICC profiling package.)

*  Number of patches: Although the number of color patches printed and measured is not always a guide to
color quality, it is generally true that printing more patches produces better results for any given ICC pro-
filing package.

11.2.3 Install the ICC profile in your RIP
The ICC profile can be installed using the Install ICC Profile dialog (Figure 13).

Install ICC Profile x|
= Use For:
- IEC Profile Information: ——————————— |~ Input Profile | Hamed Ealars
Frinter model: <unknowri: ;I P : .
ICC ITB/FOGRA/glass [T Device Link Prafile. T Emulation
Copyright by Logo GmbH Steinfurt [~ Device Profile:
MDT data included
Intent: Perceptual [bath directions] . I ; vl
Intent: Relative Colormetric [both directions] FonDevice: fRiciey)
Intent: 5 aturation [both directions) Color Soes: TR -
Linear Calibration Fram: lm
LI ™| Resample O nstal
Inztall I Cancel |

Figure 13 The Install ICC Profile dialog

In your RIP, select Color > Install ICC Profile and select the profile you created above that you wish to import.
In the Install ICC Profile dialog, select the following options:

*  Device profile: Check this option to add a profile for the output device.
*  For Device: Select from the drop-down list the device the ICC profile is to be used for.

*  Linear calibration from: Select from the drop-down list Linear if the page setup contained no color man-
agement data, or the name of the Golden state profile used to create the target.

*  The name of the calibration profile or calibration set that you used in the page setup (golden state).

After installing this profile you can use it to create a color setup, as described next.
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11.3 Creating color setups

Using the Color Setup Manager (Figure 14) and the options that are available in the New Color Setup dialog
(Figure 15), you can add your own color setups to specify precisely how you want the colors in your jobs to be
processed.

The plugin already contains color setups which are invoked when a ProofReady profile (or a calibration profile
in a pre-Eclipse RIP) is selected in a page setup. For most purposes these color setups are perfectly adequate and
will give excellent results. However, if you wish to create your own color setups and use them instead, follow
the steps below.

To create a color setup in the RIP, do the following:

1. Select Color > Color Setup Manager to open the Color Setup Manager (Figure 14).

x
Device: |3 hd Calar Space: IEMYK vl
Mame Tupe Profile

[Ma Color bManagement] Mo Color Managerment

Mew Mo Color Management' Setup... | Mew ColorPro’ Setup... |

Edit... | Copy... | [elete | Select | QK I Cancel |

Figure 14 The Color Setup Manager
2.  Select the manager options as follows:
¢ Device: Select from the drop-down list the HP device you want the new color setup to be used with.
¢ Color Space: Select from the drop-down list the color space you want the color setup to be used with.

3. Click New ‘ColorPro’ Setup to open the New Color Setup dialog (Figure 15).

B
L e 3 -
* Input Froflles Dulput Prafile

CHYE data: | (None) = | [ =] | e ‘
RiGE datar | [None] -
Il d =l Output Emulation
¥ Color marage aray o5 CHITK. [
[Nare) =y o
Gray date; [[None) =l
- Dultput Fiendering Inten
I Treat spot colors s Bk )
Main intent: [Mane) - ﬁ. 3
 Input Document Controls ———————————————————— J
¥ Overtide color management in job I CMYK images: [More) -
I~ Simulste paper color of o
™ RGB images: [Mane] [ -

¥ Preserve 100% process black
I~ Dveride overprint made in job

¥ Dverprint process colors Qi b e

I Drop whits obiects Black generation.  [None -
I~ Ovsrprint gras I~ Qs black gensration in job
¥ Qverpiint gray images Mawink: [300 | % Maxblack: [100 | %

™ Overprint 100 black.

= [~ Convert RGB black to tue black
Image orily Black

™ Use late color management [~ Output Contrals

Lighting Graphic Arts D50 ~
Ingut Separation Detection Angles in Job——————————
Cyan Magenta Tellaws Black Color adjustments: [Beter 7|

1500 7500 000 500
Cancel

Figure 15 The New Color Setup dialog (Eclipse Release)
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4. Specify your color setup options. To correctly process the color in your jobs, the following options need to
be specified:

*  Input Profiles

e Output Profile

*  Output Rendering Intents

The other options are optional and may be left at their default settings or changed as required.
5.  When you have made your selections, click Save As and enter a name for your new color setup.

To use your new color setup, select it from the Color drop-down list in your page setup.

12 Troubleshooting

The HP DesignJet printer plugin for the Harlequin RIP is an advanced piece of software which contains many
configuration options and settings. When used in a bi-directional output the printer is able to report diagnostic
warning and error messages to the RIP. These can be viewed in the console (the main RIP window), and are
described in this section.

12.1 Error messages

oe

%[ Error: VMerror; OffendingCommand: pagedevice ]1%%

Symptoms: May occur when printing on large paper sizes or with a high resolution. Some jobs may sup-
press the VM Error and print using the default page size specified in the Page Layout dialog box, so that the
output appears clipped.
Solution: Increase the setting for band size in the Configure RIP options dialog box to 1024 KB.

%% [Error: undefinedfilename; Offending Command: run] %%

Symptoms: Occurs when a device type is used with a name similar to another device, or when a new device
is created where the case of the letters does not match those used in the device type label.

Solution: Change the device name to something completely different. Open the Device Manager, select the
device and click Edit. In the Device Manager Edit dialog box.

%% [ Error: ioerror; Offending Command: setscreen ] %%
Symptoms: Occurs when HDS screening is being used when HDS has not been enabled in the RIP.
Solution: Enable HDS or HDS Light (Harlequin RIP > Configure RIP > Extras), and then re-submit your
job.

** %% *WARNING: Insufficient working set may result in paging and performance may be
affected.
*****Try logging on as a Power User or reducing the memory allocated to the RIP.

Symptoms: May occur when using the RIP under Windows 2000.

Solution: This message may be ignored since performance is unaffected and is simply caused by the way
Windows 2000 handles memory requests. Reducing the amount of memory available to the RIP may allevi-
ate this warning, however RIP performance may consequently be affected, depending on the RAM you
have available.

Not enough system memory to output this page.

Symptoms: May occur when the RIP is using more memory than is necessary for safe operation of the oper-
ating system (OS). On Apple Macs you may also see the OS display a warning message, or the system may
freeze before it has chance to display the message.
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Solution: On the Apple Mac, set the system option Minimum memory left for system to 10000 kB. Large
page sizes may need a larger value. For PC systems add more RAM to the machine.

12.2 Printer-specific messages and symptoms

Many of the printer-specific warnings are informative messages, which can be ignored without any adverse
effects. Other messages can often be cleared by aborting output from the RIP, clearing any used media from the
printer and starting the job again.

Page Layout media size is less than the Configure Device paper size - clipping may occur.

Symptoms: May occur when a custom paper size page setup is used that is subsequently changed to use a
larger paper size. Clipping may occur in the output as the media values used for the custom paper size are
still associated with the page setup.

Solution: Change the media values in Page Layout so they are larger than the paper size selected in Config-
ure Device, or create a completely new page setup.

Warning: Top and Bottom Margin values will be swapped.
Symptoms: May occur when sheet-fed devices are being used.

Solution: The message is output for information only and may be ignored. It occurs because the RIP needs
to swap values specified in the Page Layout dialog box for the top and bottom margins, so it can deal with
sheet-fed devices correctly.

Job output for "job name”, sent on <date> <time>
Symptoms: Occurs when the RIP has finished sending a job to the printer.
Solution: The message is for information only and can be ignored.

Job output for "job name”, filename "full path name of output file”, finished on <date>
<time>

Symptoms: Occurs when the RIP has finished creating an output file for the job.
Solution: The message is for information only and can be ignored.

Printer communication failed ( error details)
Unable to connect to printer ( error details)

Symptoms: The RIP is unable to communicate with the printer, as described by the error details.
Solution: Refer to the error code for the cause of the failure.

Unable to open output (error details)
Open error (error details)

Symptoms: The RIP is unable to communicate with the printer, as described by the error details.
Solution: Refer to the error code for the cause of the failure.

Unable to create file - "full path name of output file"
Symptoms: RIP is not able to create an output file for the job.

Solution: Make sure there is sufficient disk space for the output file. Also, make sure a file of the same
name does not already exist, and that the disk is not read-only.

Unable to create file using path "full path name of output file"” and template "file name

template”
Symptoms: RIP is not able to create an output file for the job.

Solution: Make sure the output path is valid and is writable. Also, confirm the template file name is valid,
as specified in Configure Device.
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Job output for "job name” is aborting - Printer will print data that it has already
received.

Symptoms: May occur after an error has been reported.

Solution: If the RIP aborted due to a problem with the parallel (LPT1) connection method, you may be
prompted to retry or cancel the job. Click Cancel to abort the job and then check that the printer is switched
on and connected using the correct cable.

Job output for "job name” is aborting
Symptoms: May occur when an output file is being written.
Solution: The message is for information only and can be ignored.
Job output for "job name”, aborted on <date> <time>
Symptoms: Occurs after a job has been aborted.
Solution: The message is for information only and may be ignored.

"

Job output for 7
<time>

ob name”, filename "full path name of output file”, aborted on <date>

Symptoms: Occurs after a job has been aborted.
Solution: The message is for information only and can be ignored.

Job output for "job name”using path "full path name of output file"and template "file name
template"”, aborted on <date> <time>

Symptoms: Occurs after a job has been aborted.
Solution: The message is for information only and can be ignored.
Printer ejects paper before completing a page
Symptoms: The page is ejected from the printer before it has finished printing.
Solutions: There are a number of possible solutions:
*  Reset the printer and try printing the page again.

*  Inyour PC BIOS, check the mode setting for the port. Do not use EPP mode, especially if a security
dongle is attached.

e Ifyour PC has a second printer port, try using this port instead.
e Swap the parallel printer cable for another one.
Poor or erratic image quality
Symptoms: The print quality is poor.
Solution: There are a number of possible solutions:

»  Check the printer is operating correctly and is able to print a self-diagnostic test page. Your printer
manual will have details on how to print a test page.

*  Make a note of any error or warning messages issued by the RIP/plugin and use the recommended
troubleshooting procedures, as described in this section, to fix the problem.

*  Check the settings used in the Harlequin RIP page setup. You may have used an inappropriate setting
for resolution or print quality.

No output

Symptoms: No output from the printer.
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Solution: Check the status of the printer: make sure it is online, powered and connected. Also, check ink
and media are loaded and ready to be used. If necessary, print a self-diagnostic test page. Your printer
manual will have details on how to print a test page.

Output appears clipped

Symptoms: Printed output may be clipped at the top, bottom or side of the page when printing with large
paper sizes or high resolutions.

Solution: Increase the band size setting to 1024 kb in Harlequin RIP > Configure RIP > Options > Band
size for printing.

Photolnk color management fails to preserve 100% process black
Symptoms: Black is not printed as 100% process black when a job is color managed.
Solution: To prevent black being color managed, add a page feature to your page setup that runs the follow-
ing PostScript:

<</ReuseColorChains false>> setsystemparams

Refer to the Harlequin RIP manual for details on creating and using page features.
Banding at 300dpi

Symptoms: Device pauses for a few seconds shortly after printing starts, resulting in a band in the first few
inches.

Solution: Increase the band size setting to 2148 Kb in Harlequin RIP > Configure RIP > Options > Band size for
printing.

12.3 Messages for file name templates

This section details possible error messages that may appear in the RIP monitor window due to the use of incor-
rect file name templates (see Section 8). Suggestions are offered to prevent these errors from occurring.

Filename too long for target platform

This message appears when the combined file name stem and extension are too long for the target platform.
For example, the combined length of the file name stem and extension must not exceed 255 characters on a
Windows platform or 31 characters on a Macintosh platform. To prevent this error, use truncated tags, as
shown in the example for the <dos> tag on page 19.

File stem too long for target platform

This message appears when the file name stem is too long for the target platform. To prevent this error,
restrict the length of the stem by reducing the fixed text, or by using truncated tags. The example for the
<dos> tag on page 19 demonstrates truncation.

Extension too long for target platform

This message appears when the file name extension is too long for the target platform. For example, file
names in UNIX are not considered to have a separate file name extension. Using the <dot > tag in conjunc-
tion with the <unix> tag would generate this error. To prevent this error, create a template such as
<unix><jobnames.hpf rather than using the <dot > tag.

Full pathname too long for target platform

This message appears when the full path name (combination of the file path and the file name) is too long
for the target platform. For example, in Windows operating systems the full path name must not exceed 259
characters. To prevent this error, examine the number of characters in the file path of the output file (for
example, C:\sw53\RIP\FILES\) and create a template in which the combined length of the file path and
the file name do not exceed the limit for the platform.
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The path was not supplied

This message appears when the file path is not specified in the Change... text box within the Configuration
dialog box. To prevent this error, provide a valid file path.

Unknown tag found in template

This message appears when an unknown tag is found in the template. This is most likely due to a spelling
error.

Tag delimiter not found

This message appears when a tag delimiter, either < or >, is missing from a tag. Check that all the tags have
both delimiter characters.

An extension is required but not found

This message appears when a file extension is expected but is not specified in the template. For example, if
using the <dot > tag, a file extension must be given.

File requested is not writeable

This message appears when trying to write to a file that already exists and that has read-only access. If you
wish to overwrite the file, you must change the file permissions to provide write access.

Unique requested but not satisfied

This message appears when no further unique numbers are available. For example, if using the template
stem<luniques<dot>hpf, this error would occur once the file names stem1 . hpf through stem9 . hpf had
been generated, because no further unique numbers are available.

12.4 Messages for post processing

This section details possible messages that may appear during post processing (for more information, see “Post
processing operations” on page 21).

Running post processing command "command” in folder "folder name"
This is a progress message, confirming the command that is being run, and the working directory.
Post processing command failed - Cannot change directory to "directory path”

This error message appears when there is a problem changing to the specified directory that prevents the
completion of the post processing. Check that the directory exists and that you have permission to access
the directory.

Post processing command failed - "status value”

This error message appears when the post processing has been unsuccessful. The "status value" is the
error code generated by the command or shell you are using and can be used by your system administrator
to determine the exact cause of the post processing failure.

12.5 Parallel port performance and reliability

We are aware of several problems with parallel port behavior when working with built-in parallel ports on PC
platforms—where the hardware implementation and supported modes of operation have changed greatly over
the development history of the PC.
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Windows2000/Windows XP

Under Windows 2000 and Windows XP the parallel port driver can achieve higher data rates, especially
when operated in ECP mode. Using this mode the operating system sometimes crashes or shuts itself down.
You can avoid these problems by reconfiguring the parallel port in the BIOS to select the most basic config-
uration. The way to enter and change the BIOS configuration varies from machine to machine, as does the
terminology used for the parallel port mode.

To avoid crashes, try using options with descriptions such as “bi-directional”. Do not choose any option
where the description includes the words ECP or EPP.

12.6 Problems with passwords

If you have problems enabling a device or option you should confirm with your supplier the password or pass-
word file. They may provide you with a new password or password file. If this is the case, you may need to pro-
vide the serial number of your RIP. The RIP displays this number in the RIP monitor window when starting up,
in the form:

Serial number: 1234-56

You must also tell your supplier the platform for which you require the password or password file. The platform
is the combination of operating system and processor type. For example, you might specify Windows NT, and
Intel processor (CPU).

Once you have a valid password or password file, follow the relevant steps:

Password file Copy the password file into the Passwords folder, which is a subfolder of the
sw folder. See the RIPMate User Guide for further details.

Password Use the File > Configure RIP menu option to display the Configure RIP dialog
box. Click Extras in the Configure RIP dialog box to display the Extras dialog
box. Select the entry for the device or option that you wish to add, and click
Add to display the Enable Feature dialog box. Enter the password given to you
by your supplier, and click OK.

12.7 Patterning when not using color management

You may see patterning in flat tint areas of black if you print without using any color management. To avoid this
problem, use the supplied calibration profiles and color profiles, as listed in“ProofReady profiles” on page 13. If
the media or screening type that you wish to use is not supported by the supplied profiles, you need to create
your own profile. If necessary, you can use the supplied profiles that are optimized for HDS Super Fine screen-
ing with all of the HDS screen sets.
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